
Blender Visualization Tutorial VizBi 2016 
Björn Sommer, Monash University Melbourne/Konstanz University (designated) & 
Chris Hammang, Garvan Institute Sydney
Version 08.03.2016

Forum: 
http://www.cellmicrocosmos.org/Cmforum/viewtopic.php?f=21&t=779

Target

This tutorial describes the basic functionality of Blender. We will learn about

• Blender Idea

◦ Background

◦ the GUI,

▪ The different Screen Layouts

• Default

• Compositing

• Animation

◦ import Plugins with the Preferences,

• Add external data

◦ how to add images,

• Navigation and Manipulation

◦ navigate in Blender with keyboard and mouse,

◦ many keyboard shortcuts,

◦ coordinate system

▪ basics

▪ change coordinate handling in GUI

◦ use the object and edit mode,

◦ basically manipulate a mesh,

• handle different layers,

• Import a PDB file,

• Rendering

◦ how to render an object with the 

▪ Blender Renderer

▪ Cycles Renderer

• how to use the Node Editor

• Diffuse light

http://www.cellmicrocosmos.org/Cmforum/viewtopic.php?f=21&t=779


What is Blender?

Wikipedia

Blender was developed as an in-house application by the Dutch animation studio Neo Geo and Not 
a Number Technologies (NaN). It was primarily authored by Ton Roosendaal, who had previously 
written a ray tracer called Traces for Amiga in 1989. The name "Blender" was inspired by a song by
Yello, from the album Baby.

Roosendaal founded NaN in June 1998 to further develop and distribute the program. The program 
was initially distributed as shareware until NaN went bankrupt in 2002.

The creditors agreed to release Blender under the terms of the GNU General Public License, for a 
one-time payment of €100,000 (US$100,670 at the time). On July 18, 2002, a Blender funding 
campaign was started by Roosendaal in order to collect donations and on September 7, 2002 it was 
announced that enough funds had been collected and that the Blender source code would be 
released. Today, Blender is free, open-source software and is, apart from the two half-time 
employees and the two full-time employees of the Blender Institute, developed by the community.

The Blender Foundation initially reserved the right to use dual licensing, so that, in addition to 
GNU GPL, Blender would have been available also under the "Blender License", which did not 
require disclosing source code but required payments to the Blender Foundation. However, this 
option was never exercised and was suspended indefinitely in 2005.[5] Currently, Blender is solely 
available under GNU GPL

Watch the Show Reels

Cycles Demo 2015:

https://www.youtube.com/watch?v=wDRTjzLNK0g

Blender Siggraph 2011 reel (Revised):

http://www.youtube.com/watch?v=QbzE8jOO7_0&hd=1

And be sure to do not miss this part:

http://www.youtube.com/watch?v=QbzE8jOO7_0&hd=1&t=180

Installation

Actual Version of Blender:
http://www.blender.org

Here, Blender 2.76 is used.We will be working with Blender version 2.76b. Go to the Blender 
website, and download the version for your OS.

Abbreviations

RM – Right Mouse button

CM – Center Mouse button

LM – Left Mouse button

Preparations

Menu → File → User Preferences

http://www.blender.org/
http://www.youtube.com/watch?v=QbzE8jOO7_0&hd=1&t=180
http://www.youtube.com/watch?v=QbzE8jOO7_0&hd=1
https://www.youtube.com/watch?v=wDRTjzLNK0g


→ Addons:

activate: 
Import-Export: Import Images as Planes

→ Input

activate “Emulate 3 Button Mouse” for using Blender with a Mobile PC

Moreover, if you do not have a Numpad on your computer (but only in this case!), activate 
“Emulate Numpad”.

Make also sure that “Continuous Grab” is activated, which will enable you to, e.g., enlarge objects 
moving the mouse without being limited by the outer limits of the monitor.

Press: “Save As Default/Save User Settings” to make sure, next time you start Blender, you do not 
have to redo these settings again.

Shortcurt keys

Now, a number of shortcuts will follow. Of course it is a good idea to remember most of the 
shortcuts in the future on your own, because working with Blender is extremely much faster with 
shortcuts instead of using the menus. However, to support you during your work, KatsBits provides 
a very nice keyboard chart which you can download here for free:

http://www.katsbits.com/tutorials/blender/useful-keyboard-shortcuts.php

http://www.katsbits.com/tutorials/blender/useful-keyboard-shortcuts.php


Object Mode

First, select all objects in the scene. In the standard scene, this is the cube. Select it with RM, 

Then, create a Cube:

 
You should now update the values of the last added object, which is now of course the cube. 
Change the location and the “radius” to 1.0 and the location to 0/0/0, so that it is located in the 
center of the viewport.

Selections

Normal written is mouse handling, in brackets: [ Apple Touch Pad, might also work on touch 
pads providing multi touch]

Right Click [ 2-Finger Click]: Select closest object under Mouse or unselect if no object under 



mouses

Left Click [ 1-Finger Click]: Change position of 3D cursor (how to use it is explained later)

Alt+Left-Click [ 1-Finger Press+Option/Alt key] or Center Mouse Button [ 2-Finger Press]: 
Emulate Center Mouse Button & Rotate
Center-Click+Shift: move horizontally/vertically
Center-Click+Ctrl: zoom in/out

Ctrl+Left-Click: Draw Shape and Select

ESC → Back to 3D View if e.g. in Render Mode

Camera and Perspectives

Num-Pad
1 : Front
3 : Side
7 : Top
CTRL+# : Opposite (e.g. CTRL+1: Rear)
5 : Orthographic/Perspective View
4,2,6,8 : Rotate in 45° steps
0 : Switch Camera View/Perspective View 
CTRL+0 : Switch active camera to the selected one
Shift+F : Free Floating Mode for Camera/Perspective View, 

  Use WASD to navigate, finish with left click
+/– : Zoom in/out
Pos1 : Show all objects
Shift-C : The view is shifted to show all objects



Manipulation Modes

G : Grap
R : Rotate
S : Scale

G/R/S+Axis : Translation/Rotation/Scale along the chosen Global Axis (X, Y, Z)
G/R/S+2xAxis: Translation/Rotation/Scale along the chosen Local Axis (X, Y, Z)
+Shift : Translation/Rotation/Scale along the chosen Plane (X/Y, Y/Z, Z/X)

  (e.g., press Y (as the normal) → X/Z plane is used)

Combined with Alt: UnDo (“Object Mode”; not in “Edit Mode”)

Ctrl+Space: Show/Hide Manipulators

Select here the manipulator needed  (in this case the arrow):

Transformation orientation, e.g. “Local” or “Global” are used, to define the base coordination 
system for the manipulators 

Change to “Local” and look what happens.

Then, change to “View” and look what happens.

If you did not change the rotation of the cube, you should not see a difference. Move the cube by 
pressing G to another location. Press then R to rotate the cube. Now, change again between Local 
and Global mode. Now you will see a change.

       Global     Local View

The global refers to the global coordinate system. The local one refers to the coordinate system of 
the object. And the one of the view to the actual view port. For each setting there are application 
cases where one of these coordinate systems will be the best option.



Left-Click on Arrows of Object → Movement along the chosen axis
Ctrl+Movement: in full Blender steps
Ctrl+Shift: Movement in 1/10 Blender steps

Use of Layers

Blender provides 20 layers. They can be toggled on and of by clicking at them.

Here, four layers are visible, and in the first layer our actual object, the cube, is located.

To toggle them on and of with the keyboard, just use the number keys (NOT on the NUM pad) 
1,2,3..0 to toggle the upper layers, and press the ALT [alt/option] key to toggle the lower areas. To 
combine the visibility of different layers, press the SHIFT key.

Note: If you do not have a laptop with Numkeys and activated the emulate Numpad in the Blender 
properties, the keyboard support for layers is not available anymore.



Undo Options

Ctrl-Z: Undo (32 Undos, can be changed File → Preferences → „Editing“ → Change Size of UnDo
History)

Ctrl-Shift-Z: Redo

The Last Action/Transformation is shown here and can be manipulated

Origin → change the Gizmo of an object



Edit Mode

Tab: Edit Mode (toggle between Object and Edit Mode)

select with Right Mouse Button single vertices

Shift: Multiple Selection, keep pressed by selecting 4 nodes

S + 0 + Enter → Place all selected nodes in one place 
(S for scale, 0 Scales the distances between all selected nodes to 0; 
 pressing S + 10 would scale the distances between all selected nodes to the 10 th of their length;
 this method can again be combined with X, Y and Z restraints, e.g. by selecting S + X + 0;
 watch the actual scale on the left bottom corner shown below)

W : “Specials” Pup-Up for Edit Mode appears, select:
  Remove Doubles: Removes all overlapping vertices in one position, 
  e.g. after using S+0

Further ShortCuts:

X or DEL [ fn+DEL] : Delete Objects



Change the origin of an object



Shift+A: Add Objects to actual object (remember, we are in Edit Mode, these objects will be not a 
single object, but they will be added to the actually edited object) or 

Selection Modes

Ctrl+Left Click : Selection in Pencil Mode

C : Brush Mode (ESC to exit)

Ctrl + Tab : Change Sub-Edit Mode: Vertex, Edge, or Face

A : (De-)Select All

Manipulation Modes

Vertex select : Select vertices
Edge select : Select edges
Face select : Select faces
+Shift : Select multiple vertices/edges/faces
+Ctrl : Select all vertices/edges/faces between previous and actual selection

E : Extrude vertices/edges/faces

first select two unconnected vertices and
W → Merge ... : Combine and merge two vertices
or
F : A direct edge between both vertices is added

first select three or more vertices connected by edges (but without a face in between)
F : create face between vertices

first select two connected vertices and 
W → Subdivide ... : A new node is added between the preselected two vertices

first select a single node as starting vertex
CTRL + LM : A new vertex plus edge between the preselected vertex is added

API-Navigator

Help → Python API Reference



The Python-Scripts executed by Blender are always shown in the top section which is normally 
hidden. To open this section, the yellow marked line (see screen shot) has to be dragged down with 
the Mouse+LeftPress.



Properties Window

N → Properties of the selected object



Background Image

This image is only shown in view ports, e.g. in the camera perspectives:

(this is still the properties dialog)

This maybe useful if an image should be used as a base for a three-dimensional object, e.g. image 
segmentation. Important: If “All Views” is chosen, the images are only shown in orthographic 
perspective, which is toggled by “5” on the NumPad

→ Therefore, usually it will be needed to correlate an image with a plane:

A Plane with an Image

The complex way

(Attention only for those who plaid around with the render settings: use the standard renderer: the 
Blender Renderer)

Create the Plane:



Make sure, that “Textured Solid” is checked in the properties (Press N to toggle properties):

Create a new Material (the plane has to be selected):



Create a new Texture:        →      →

The easy way



World Background Settings

Change the Light/Background Settings in the World Options:

Some new Options and a few Repetitions

B → Border Select 

H → Hide all selected

Shift+H → Hide all unselected

Alt+H → Unhide all

A → De-Select All

W → Specials: Subdivide line between selected vertices

Shift+D → Duplicate

Alt+M → Merge selected nodes (Edit Mode only)

E → Extrude selected nodes or shapes

F → create face between selected vertexes



Modifiers

Modifiers can be used to change the appearance of an object without changing the original shape. 
Modifiers can be temporarily deactivated. If you want to unite the object with its modifier, just 
press “Apply”.

Generate/Subdivision Surface

Generates a smoother surface. 
View: Subdivision surface factor for the actual 3D view. 
Render: Subdivision surface factor for the  next rendering.

Generate/Mirror Modifier

Mirror the next manipulations along one or more predefined axes



Generate Basic Cell Objects

Endoplasmic Reticulum
Start from a cube and use the E – Extend tool in edit mode in combination with the select faces 
settings:

Select always one single face with right click and extend it into the actual direction

Create in this way a labyrinth-like network. During the creation process, you can also scale single 
segments by using S.

Now we want to convert the network to a tube-like structure. For this purpose, the Subsurf modifier 
is added, and increase the subdivision factor to 4 for View and Render:



The result should be similar to this image:

But the surface is not smooth. Change the setting here by pressing Smooth:

To make a simple animation of a deformation process, we add a wave modifier:



To define, from where the effect should start, we add an empty object to the scene:

Set the position of the Empty object to the position the wave effect should start, and then add the 
Empty object to the Wave modifier as Starting position:

If you press now the play button, you will see, that the wave effect is animated!

Still the surface is to regular for a organic structure, so add a Displacement modifier:



You see here that a texture was used. Configure the texture like this:

If this effect should be animated, change e.g. the strength over time in the modifier:

Go to frame 0, RC on Strength and select “Insert key frame”. 

Go then to, e.g., the last frame, change the Strength to twice as much, RC on Strength and select 
“Insert key frame”. 

A resulting frame might look like this:



Add now a nice surface to it, e.g.:



We named the material “Red Refraction”, so that it is later more easy to assign it to other objects. 
You can edit these settings also in the Compositing screen layout, change to it here:

This is the corresponding node configuration:



Change back to the Default screen layout.

To see the rendered model in the 3D view, use this setting here:



Simple Merging Cells

To add simple merging cell shapes to the scene, use the Metaballs object.

Add two of them to the scene and observe what happens, if both touch each other. 

You can also animate this effect by using key frames. But first, let us move the objects to another 
layer by pressing m and selecting another layer. Press here another layer than the first one:

Then, change to the last-selected layer (in our case the third one):

Move one object apart from the other one:



Select Rot/Loc/Scale as the active keying set:

Activate both options here to automatically record changes:

Now go to the last frame and change the position so that both objects merge, and go to the first key 
frame and move the objects apart from each other. Press play, and you will see that the animation 
already works!

You might want to assign the same material as the one used for the previous model. Just go to the 
material dialog and select:

Make sure to deactivate the automatic key frame generation before you proceed!



Another option to edit the animation, is the screen layout Animation:



Mitochondrion based on an EM image

First, we import an EM image as plane. I used here an image from the Cell-Centered Database:

http://ccdb.ucsd.edu/sand/main?mpid=3487&event=displayRaw

It shows a slice through a cell, showing a mitochondrion and an adherens junction:

But we are just interested in showing the 3D model of the mitochondrion together with the EM 
image.

Import the image as plane!

Position the plane in the center of the grid:

http://ccdb.ucsd.edu/sand/main?mpid=3487&event=displayRaw


If you switch now to rendered mode: 

the image appears, but the contrast is very low.

Go again to the Compositing Screen Layout and apply the following changes to the nodes:



The contrast is now drastically improved!

Use now the previously learned methods to create a mitochondrion. Start with a cube, place on top 
of the mitochondrion in the image, and then use the extrude and scale options previously described. 
This is an example in wireframe mode:



Add again a subsurf modifier:

Add a material:

Copy it (CTRL+C/CTRL+V) and shrink it to create the inner membrane of the mitochondrion:

Now we want a matrix-like structure. Copy the inner membrane again and shrink it , and this time, 
use the following modifiers:



A folded structure is the result:



Play with the settings now to improve the results. Make also sure that the matrix is inside the inner 
membrane, which has to be completely inside the outer one!



Create a simple Camera Path

Create a Bezier Curve.

Go to edit mode while having the new curve selected, and change the start and end position to the 
one the camera should be located:



Add a Camera Path

Finally, we want to animate our camera.

First, create a NURBS path:

This path will be the one our camera will move along. So make sure that it has the correct shape and
position. However, you can also change it later – this is one of the basic advantages in comparison 
to animating the camera with key framing. Of course, also the visible control over the movement of 
the camera is much better.

Create a new camera, set this camera as the actual one (CTRL+0). Make sure you are on the right 
layer where the camera is visible, eventually you have to move the new camera to the same layer 
the mitochondrion is at. Then, attach the camera to the path. For this purpose, select the camera, add
the object constraint “Follow Path” and select the newly created path.

Now, the camera is associated to the path with a line. But usually, the position of the camera is not 
correct. Make sure to set it to manually set it to the starting point of the path, like in this image:



In this image, two additional changes were done. Add the “Damped Track” modifier to the camera:

Create then an empty object, place this object in the center of the mitochondrion, and define it as 
Target for the Damped Track, see image on top.

To make sure that the empty object is always visible, also inside other objects, just select “X-Ray”:

Make now sure, that all coordinate variables are correctly defined, so, that the camera is directed 
towards the object and the rotation is also correct. In the Follow Path constraint, make sure “Follow 
Curve” is selected and then press “Animate path”.

Now, if you press play, the camera moves along the path while the direction is always towards the 
defined target.
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